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The Editors Notes
Dear Members
This is a desperate plea from your editor, what you see here is the last of my useable copy
supplied by you the members. So I am in desperate need for new articles.
I am looking for articles of any size up to a max size of 1500 words which is about three pages. So
if you include picture’s allow less. Tell us about your special trips, the special adventure you went
on, special techniques, new software and your experiences with them etc or whatever comes to
mind. If you have any questions or need help, please email me on the address at the front of the
magazine and I will get straight back to you.
You will see a new article from Paula Davies about her 8 desert island images. I think this a great
idea for an article. Unfortunately 8 images is going to be just too long so I would love to other
members works to the following criteria.
Tell us about your 5 images you would take to a desert island and why, please use Paula’s article
as a template. When you have your article ready please make contact and I will let you know how
to transfer the copy. Please do not design the page, I will do all that.
Please remember this is your magazine and will only work if your support it.
Thank you. Paul Hoffman EFIAP CPAGB BPE3* The Little Man Editor.
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The Presidents View
Hello Members,
It gives me great pleasure to be your President for a second
time,
It was a great to see those of you that could attend the AGM
Convention and I hope many more will be able to attend
this coming year.
I am supported by a hard-working committee working
throughout the year to ensure that UPP runs smoothly for
our members. The exhibition secretaries start work in June,
with Ken collating all the entries ready for judging, which is
organized by Ray. Then the hard work starts in preparing
the DVD (and memory sticks) to show the exhibition as well
as other goodies. We owe a lot to these gentlemen and to
Helen who helps in the design and hanging of the exhibition.
Ian works in the background to, He is the one who supplies
the secretaries with all the paperwork which goes in to your envopacs and black boxes.
Francis is our longest council member along with me. Francis looks after the money side of things
(extremely efficiently!) and handles the logistics involved in booking Hillscourt Conference Centre at
Rednal where we hold our AGM. He organises the booking of accommodation and food for those
that wish to stay. Francis has told me that we have been at Rednal 25 years this year
Paula is our webmaster and she has made a brilliant job of it, It’s a website to be proud of so show
your friends and create interest in UPP, Paula is also my Vice President.
Our main man with the words is Paul our editor who puts together a very good read in The Little
Man magazine to be kept on your bookshelf for years to come. He has taken the magazine from
strength to strength.
Lastly my thanks has to go to Ralph Bennett who stepped in a last minute to take over the secretary
role and gets us through the AGM and out first formal meeting for a while. Unfortunately Ralph is
unable to continue with this role, so we now have to find a replacement which has to be in place by
the AGM for us to uphold the constitution, so please think about supporting your UPP.

Our membership has fallen slightly and the best way to recruit new members is by word of mouth,
so when you meet up with your photographic friends or go to your camera club please mention UPP
to them. Our Publicity Secretary, Colin, has leaflets which he could send to you to help swell our
membership, you can find Colin at questphoto@btinternet.com. Or go to our website and click on
publicity. You will get one year’s free membership if you introduce a new member as you know we
have circles to suit everyone.
My other job on council is membership and welfare secretary so I get to know you all from the very
beginning of your journey with UPP which I hope is a happy and long one.
Take care everyone Liz Boud
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The Presidents View
General Secretary
Owing to unforeseen circumstances the position of General
Secretary has become vacant and the committee is looking for a
volunteer to fill this very important position.
We are looking for someone who is familiar with MS Word and
is as passionate about the UPP as we are. Full support will be
given by the committee. Please contact Liz Boud if you are interested.

__________________
Thank you Secretaries
Without our hard working secretaries the UPP would not survive.
Some of our secretaries have been with us for years, some are very new but all are
doing a sterling job.

But circles need to have members and you can all help by recruiting your
photographic friends to UPP. We have found that word of mouth is the best way
and remember you will get a free years membership if they join. Just give them our
website details and the application form can be found there. To aid you we have
produced Publicity leaflets which are available by request (publicity@uppofgb.com)
to hand out to club lectures, judges etc. but also just to take to your club to give to
friends etc. Thank you for your continued support.

_________________________

New Circle
UPP is planning to introduce a circle for images taken and processed on a mobile
phone/tablet. If you are interested and would like more information please contact
Paula Davies, UPP Vice President and Webmaster, by email to
webmaster@uppofgb.com.
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My Desert Island Pictures
by Paula Davies FRPS EFIAP/s EPSA CPAGB
When I was asked which eight photographs I would take to a desert island I thought
it would be difficult to find that many. However once I started to look through my
files in Lightroom I found more than enough and then I had to whittle them down to
the required 8. So rather than choose several pictures of the same type I decided on
8 that showed more variety in style. As you will see from my choice my style is not
to have a style. I call myself a butterfly photographer as I flit from subject to subject.
I enjoy trying to manipulate pictures creatively but am also happy with straight
images. My favourite quote is this one from John Barclay, an American
photographer, whose work I admire. “I have no interest in making images that look
like what I saw, I am more interested in creating images that convey what I felt or
saw in my imagination. I don’t want to be restrained by what others think I should
do but rather create what will make my heart sing.”

1. Proud Housewife
This has to be a favourite as it won
me my very first gold medal in an
international exhibition. I was with
a group visiting a remote village
near Trinidad de Cuba. The others
in the group were enjoying
photographing an old steam train
but I had become bored with that.
As I was taking some shots of
flowers outside one of the village
houses this lady came towards me.
She beckoned me towards her
house (more shack than house) and proceeded to show me around. I lifted the camera and smiled at her and she sat down and posed for me. Not a word was spoken –
I don’t speak Spanish and she had no English. As you can see she was in the middle
of doing her housework and she is still holding her broom. There is what looks like
washing over the back of the seat in the background. Taken hand held using natural
light from the open door.
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My Desert Island Pictures
2. Carnival Time
I have been to Venice at carnival
time twice and I feel that this image
sums up the excitement of being
there. The three people in identical
masks and hats were photographed
outside the Doge’s Palace early one
morning. One New Year’s Eve I was
feeling bored and started to play
around with
another shot of one
of the three. Having found a plug-in
on the
internet called Kaleidoscope I had hoped to make a kaleidoscopic image
but there was a button marked ‘random’ and I was intrigued to know what it did. So
I pressed it a few times until I had a random pattern picture in red and orange hues.
I thought that this would make a good background for a portrait of one of these
characters. As we had been invited to dinner with friends I quickly made a ‘Happy
New Year’ card from the result and took it with me. When I was in bed that night,
after probably eating and drinking rather more than I should, I found that I was
wide awake and started thinking about the image that I had made. In my head I
made up a collage of parts of Venice such as the Doge’s Palace, lamps, gondolas and
the carnival masks. So on New Year’s Day I sat at the computer and created the
image that had been in my head.

3. Autumn Shades
This has to come with me to the desert island as it
reminds me that I can achieve a pleasing image when I
really didn’t expect anything at all. I was on a workshop
with Paul Foley’s ‘Spirit & Vision’ visiting Bryce, Zion
Canyon, Antelope Canyon etc. We were staying at Kanab
which is not a known photographic location. Anybody who
knows Paul will know his love of trees and subtle colour.
Before sunrise we were taken to a location where the
vehicles could be parked on a wide grassy verge. At the
edge of the verge one could look down at a large area of
7

My Desert Island Pictures
grasses and trees. By now it was light but this area was not lit by the sun. I took
several compositions but wasn’t convinced at all that I was getting anything
worthwhile. Imagine my surprise and delight when I opened the images on the computer and found that I didn’t have to make any tweaks to the RAW file to produce
this result.
4. Closed for the Winter
One November we were visiting
friends, also keen photographers,
who live on the south coast one
November and decided to visit
West Wittering. It was a cold and
windy day. As we walked along
the beach we came across these
beach huts where the wind had
blown the sand up into a huge
dune in front of them. Three tripods were set up as if
synchronised and we all took the same shot. Without any reference to each other
we all processed our files
differently, one in monochrome, one in pastel shades
and mine in stronger colours. I was using the Orton effect for my interpretation,
placing a blurred layer over a sharp layer in photoshop and playing around with the
blend modes. We were very lucky as the bulldozers were nearby clearing the sand
away from the huts and moving it back on to the part of the beach that it had come
from.

5. Steampunk
This is a picture which took a long time to develop. The
steampunk was photographed at a Whitby Goths
weekend. She was half way up the steps to the abbey
with the coastline as a background. It was a bright sunny day, not one that you would associate with goths
and steampunks. I decided to make a selection of the
steampunk and put her on to a new background of the
abbey ruins. The only images I had of the abbey were
taken on days when the sky had been flat and grey so a
8
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new sky had to be added. I decided on a sunset but of course the abbey ruins then
needed to be warmed up. I added the birds taken on a club outing to the Farne Islands. The resulting composite was put in to a private group where images were
critiqued. The other members of the group felt it should be a darker, so I darkened
it and posted it again. One particular member was very helpful, saying it should be
darker still, and sent me instructions on what he thought I should do in Photoshop.
So I followed along and eventually came up with this.

6. At the End of the Day
Taken in Romania. Although it was a photographic workshop the visit was more
about the culture and people of Romania than landscapes. For the second half of
the trip we were based in Transylvania and visited a traditional village for a day. We
were taken on a cart, pulled by horses, into the fields for a lunchtime picnic. We
visited the blacksmith, the brick maker and the carpenter. After a dinner of mutton
stew cooked outside over an open fire we were taken to a road junction at the edge
of the village where we waited, literally, until the cows came home. It was sunset
and the animals brought themselves home to the village. Dust was flying everywhere and shooting with a wide angle lens I found myself surrounded by cows and
horses. The cows knew where to go to be milked before settling down for the night.
We were even allowed to watch the milking before leaving the village. It was a long
day and an experience I will never forget.
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7. Waiting for a Friend
A small group of Stokesley PS members
spent a few days in London. Our guide was a
club member who had lived and worked in
London and knew his way around. One of
the many places we visited was Tate
Modern. As we waited for the lift I noticed,
through translucent glass, the shapes of the
table, chairs and person having coffee. The
image is as seen and the only work in
Photoshop was to clone out some lines of
fluorescent lights.

8. Faded Glory
Since June 2014 I have undertaken a photo
a day project. Sometimes it is hard to know
what to take but at other times
opportunities present themselves. Being a
keen gardener I often find flowers as
subjects for my photo of the day. I had
bought some oriental lilies as I needed a
subject for a 3 of a kind competition at the
photographic society. Quite often flowers
die and decay gracefully and this was the
case with the lilies. As they faded they
became even more interesting and so had
to be photographed. I processed the image
with Nik Silver Efex choosing a suitable
preset and border.

I do hope that I can take prints rather than PDIs to my desert island as the papers
they are printed on are as important to me as the actual image.

Paula Davies. www.pixelfoto.co.uk.
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Blast from the Past
The Little Man—Summer 1984

Dry Rot
John Murdoch takes a quizzical look at the
Mad World of Photography
In normal circumstances, the couple crossing the local shopping precinct would
scarcely have attracted a second glance. The woman was large, self-assured and
voluble, the man small and insignificant by comparison. Everything about him
drooped; his mouth, his not-quite-bandit moustache, his narrow shoulders and even
his Marks & Sparks trousers sagged dispiritedly combining to give an impression of
total and
permanent misery. It is a sight not unusual in these parts and possibly
elsewhere. The thing which distinguished this particular tableau was however the fact
the man was wearing a rather bedraggled tee-shirt with the words, “OFFICIAL
HOOLIGAN” printed in large letters on the front, a clear case if ever there was one of
reality conflicting with advertising. Now, generally speaking, the advertising profession is not one which is deserving of much sympathy thought, occasionally, it needs to
be protected against itself. Only recently we have been extorted by the television advertisements: ‘If you are thinking of going to Spain – think again’, advice which, idiom
being what it is, would have most of us hurriedly scanning the holiday brochures
again in search of somewhere more appropriate. There was also the case some time
ago of a small order firm advertising with unusual and possibly unintentional candour: ‘--- we are offering this radio at a price which bears no relation to its true value’.
They went bankrupt of course.
When the publicity men really get into their stride, which they all to often do, it
unfortunately means trouble for the unwary. One wonders, for instance, just how
many thousands of pounds have been squandered on the acquision of ‘creative’
filters. Leaving aside the quibble that the filters left to themselves wouldn’t create
anything, just how often can they be put to use without being boringly repetitive?
Quite a number of years ago, a (then) prestigious international transparency
exhibition was taken by its perpetrators on a tour of the northern part of the country.
After a few trendy slides of doubtful artistic merit there was quite an arresting picture
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of a backlit glass jug, decanter and wine glass, which was awarded a certificate of
merit, if memory serves correctly. Three slides further on there was a virtually
identical set and after another five slides yet another glassware motif in no way
different to the other two. As time went on, it became evident that it had been a
vintage year for the jug and bottle department and what was initially appealing to the
senses became less so after about the fifteenth similar offering. Mark Twain met
similar trouble in Switzerland when he and his companion were approached by a
yodelling native to whom they gave a franc for his trouble. A few yards (metres?)
further on they were confronted by a second yodeller whom they awarded with half a
franc. The third they greeted with nothing but a lifting of the hat while the fourth they
tipped with half a franc to stop yodelling.
The Point is that once a thing ceases to be a novelty it becomes a nuisance and one
cannot help wondering whether the proliferation of these filters has done more
damage to the art of photography or to the pocket of the gullible.
In the same vein, an even sillier piece of publicity has been the extension of the
already ‘---- of the year’ series to ‘ Camera of the Year’. Inconceivable as it may be,
there are undoubtedly those who will dash out and buy a so-called ‘Camera of the
Year’ chosen by a self-appointed committee of alleged experts irrespective of whether
it suits their needs or not. Still, there are those who think that the winner of the Miss
World Contest is the most attractive girl on the face of the earth or even that Barry
Manilow is a singer. But to what extent does the Camera of the Year (1983) lose its
artificial desirability when Camera of the Year (1984) is designated?
Apart from the now customary mutilation of the English language, to say nothing of
grammar, there is another distasteful aspect of contemporary advertising which has
been gaining ground in recent years and that is the ‘knocking’ advertising. This first
surfaced in the car industry where, instead of the merits of the particular model being
prompted, the copy sets out the alleged defects of the competitors. Some years ago,
one of the international food companies ran a competition part of which was to
complete the sentence; ‘I like****’s soups because ………………’. Being very much
concerned with accuracy, I added, ‘…all the others taste even worse and was duly
awarded a consolation prize. This may have unwittingly set a pattern which spreading
to the photographic world in which things are sold not on their merits but on the
12
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short-comings of the opposition. It doesn’t seem to have spread to the Circle voting …
yet.
The column does not wish to give the impression that it is against progress and indeed
is a strong support of it so long as the progress is real and not pseudo and that in that
in the making of it some of the old wisdom is not lost. For instance, it emerged in a
recent discussion on fixing bath life, that no-one had heard of the simple way of assessing whether or not a hypo bath is still usable or not, something surely worth
knowing these days. You make up a solution of potassium iodide; the actual strength
is unimportant but say about 10%. Take some of the suspect hypo solution in a test
tube, hold it at an angle and let a couple of drops of the iodine solution trickle down
the side (inside, that is). If you can make Irish Coffee you won’t have any problem. If
you can’t make Irish Coffee, potassium iodide solution is cheaper than Irish Whisky,
taste much the same and is good to practice on. If, when the iodide solution meets
the hypo the solution remains clear it is safe to go on using the fixer. If a yellow
precipitate forms which dissolves on shaking, the fixer is nearing the end of its useful
life. If the precipitate doesn’t dissolve, the bath is exhausted.
Finally, a story about the great Lancelot Vining, ex-Fleet Street Photographer and regular contributor to the Amateur Photographer when it used to be a photographic
journal. Some of the older readers of this magazine will remember him as a very good
photographer but who never lost that humility and reticence which is associated with
newspaper staff. In later years he went round the country giving illustrated talks on
various photographic matters and he was very much ‘Sir Oracle and when I open my
lips let no dogs bark’. Now at this particular time he developed a pet hate, not
without good reason, towards the bonk, bonk, bonk map-pole on the floor technique
of signalling to the projectionist to change the slide. He therefore through the
columns of the A.P. warned that he would note in his Black Book any club which in
future failed to provide a discreet signalling system consisting of a length of cable, a
battery and light at one end operated by a bell push at the other. All went well until
one week when his column started in a very pained manner; “I do not know if the ----- club was trying to pull my leg or whether they simply didn’t grasp the idea . . . “ but
the unfortunate club had carried out the instruction to the letter – with one
exception. Instead of a lamp they had fitted a whacking great bell at the other end . . .
. . . . .!
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Perfect Image Blending in Photoshop
HDR The Natural Way
by Ray Grace ARPS, DPAGB
Introduction
There are a number of applications and Photoshop plug-ins available for blending HDR images but the
best way to get a natural blend is done by just using layer masking. It’s just a matter of loading the
images into Photoshop as layers in one document, arranging them in the correct order and then
applying layer masks to the layers – in the correct manner.
In this demonstration the three images of a field of stooks at sunset (shown below) will be used.

The image on the left is 2 stops overexposed – to show the shadow details. The centre image is taken
at the camera’s meter reading and the image on the right is 2 stops underexposed to capture the highlight details.
Method
In Bridge, select the images to be used then from the menu select: Tools > Photoshop > Load Files into
Photoshop Layers. The images should load straight into Photoshop, bypassing Adobe Camera Raw
(ACR).
Should the images need some adjustment in ACR then simply highlight the images and select: File >
Open in Camera Raw (Shortcut Ctrl/Cmd+R). Once any necessary adjustments have been made, click
the Done button at the bottom right of the ACR screen to return the images to Bridge. Then use the
opening method suggested in the previous paragraph. In this example the highlights and whites in the
middle image were darkened.
Ensure that the Layers panel shows the overexposed image at the top of the
layer stack and the underexposed image is at the bottom of the stack, as
shown on the right.
If necessary, align the layers. Click on the top layer then shift click on the
bottom layer to activate them all. From the Menu select: Edit > Auto align
layers. Click OK. Crop off any misalignments at the image edges.
The sky in the topmost layer is well overexposed. A layer mask needs to be
applied to hide the overexposed areas and reveal the sky in the layer below.
To do that, activate the Channels panel and Ctrl/Cmd+click on the RGB composite layer. This will select the highlight areas in the image (all levels from 128 to 255).
Activate the layers panel and, with the top layer active, click on the Layer Mask icon, outlined in red,
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HDR The Natural Way
above. A layer mask with the selection in place will be added to the layer. However, this layer mask is
revealing the highlight areas whereas the opposite is required. To invert the layer mask around use the
shortcut Ctrl/Cmd+I. The sky in the top layer will be hidden, revealing the sky in the middle layer.
Note: to cut out that step and load an inverted layer mask, hold down the Alt/Opt key as you click the
icon and the mask will automatically be inverted.
There is some detail in the lowest (underexposed) layer that can contribute to the image so a layer
mask needs to be created from the highlights in that layer. However, before doing that, it’s essential to
switch off the two uppermost layers. When Ctrl/Cmd+clicking on the RGB composite channel the highlights that will be selected will be from the brightest image on view. Therefore it is important that this is
the highlights in the underexposed layer. Switching off the two upper layers will ensure that.
Activate the Channels panel and Ctrl/Cmd+click on the RGB composite layer. Once again the highlights
in the layer will be selected.
Activate the layers panel and reveal the upper two layers. Click on the middle layer to activate it, hold
down the alt key and click on the layer mask icon. This will load an inverted mask onto the layer, revealing the highlights in the lowermost layer.
The image will, most probably, be quite flat and need further adjustments. However, a very natural
blend will be in place without looking like an obvious HDR effect.
In this image a Levels adjustment was applied to the layer mask on the middle layer to darken it a bit
further.
With the top layer active the image was then taken into the ACR filter and some Clarity and Contrast
was added.
To finish off, the image was cropped to remove some of the sky, a gradient was added to the sky using a
50% grey layer, a Curves adjustment layer was added to increase contrast just a little more and Warming Photo Filter was applied to enhance the evening colour. The final image is shown below; a natural
looking HDR.
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United Photographic Postfolios of Great Britain
2018 Annual Competition
LEIGHTON HERDSON PRINT TROPHY & PLAQUE
& BRIAN DAVIS PORTRAIT TROPHY

A Child’s Prayer by Ray Grace. ARPS DPAGB (C29)
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United Photographic Postfolios of Great Britain
2018 Annual Competition
LEIGHTON HERDSON PROJECTED IMAGE TROPHY & VASE
GLENN VASE NATURAL HISTORY TROPHY & PLAQUE

Cheetah and Six Cubs by Ralph Snook ARPS DPAGB EFIAP - (C45)
AQS NATURAL HISTORY PRINT TROPHY & PLAQUE

Tufted Grey Langur Monkeys by Geoff Jackson CPAGB (C30)
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United Photographic Postfolios of Great Britain
2018 Annual Competition
ROLAND JONAS LANDSCAPE TROPHY & PLAQUE
BEST LARGE PRINT - PLAQUE

Dawn Over Salina by Andrew Nicoll (C71)
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United Photographic Postfolios of Great Britain
2018 Annual Competition
RALPH COUCHMAN CREATIVE TROPHY & PLAQUE

LIZ BOUD AUDIO VISUAL ROSE BOWL & PLAQUE

Cold, Cold Fields of Home
By Val Johnson DPAGB C52
19

United Photographic Postfolios of Great Britain
2018 Annual Competition
GOLD STAR CIRCLE – PRINTS

C29 Small Print
(Secretary – Colin Westgate FRPS DPAGB MFIAP)

(1)

(2)

(5)

(6)

(9)

(10)

(3)

(4)

(7)

(11)

(8)

(12)

(1) ANN MCDONALD ARPS DPAGB AFIAP_Three Fishermen at Dusk

(7) COLIN WESTGATE FRPS MPAGB MFIAP APAGB Village Girl, India

(2) HUGH MILSON FRPS MFIAP EFIAP. Colours of Seilebost

(8) RAY GRACE ARPS DPAGB A Child Prayer

(3) ROY ESSERY MPAGB Morning Glory

(9) MARTIN STEPHENSON Steam and Diesel

(4) ISABELLA KNIGHT ARPS CPAGB Curves and Colours

(10) CHRIS ALDRED ARPS DPAGB BPE1 Treescape, Skye

(5) RICHARD CHERRY ARPS DPAGB EFIAP BPE5 Modern Art Gallery

(11) MONTY TRENT LRPS Stairs in the Wood

(6) CHRISSIE HART ARPS DPAGB Oyster Catcher

(12) ADRIAN BOWD Jokulsarlon Lagoon
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United Photographic Postfolios of Great Britain
2018 Annual Competition
GOLD STAR CIRCLE – PROJECTED IMAGE
C45 Projected Image—(Secretary – Bob Crick)

(1)

(4)

(2)

(3)

(5)

(6)

(7)

(8)

(9)

(10)

(11)

(12)

(1) PAT KEARTON LRPS DPAGB - Elephant's Reassuring Touch

(7) BOB CRICK - Little Blue Heron with Fish

(2) STEVE CHADD - Heron

(8) BOB CRICK - Sandhill Crane Calling

(3) STEVE CHADD - Kingfisher

(9) RALPH SNOOK ARPS DPAGB EFIAP - Cheetah and Six Cubs

(4) BOB CRICK - Common Guillemot in Flight

(10) RALPH SNOOK ARPS DPAGB EFIAP - Collared Aracari

(5) BOB CRICK - Common Guillemot

(11) RALPH SNOOK ARPS DPAGB EFIAP - Corn Bunting Dispute

(6) BOB CRICK - Hoverfly at Dawn

(12) RALPH SNOOK ARPS DPAGB EFIAP - Fiery-throated Hummingbird
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United Photographic Postfolios of Great Britain
2018 Annual Competition
SELECTORS CHOICE AWARDS

Judge Barry Mead FRPS EFIAP/d1 award
On The Edge by Colin Douglas ARPS DPAGB AFIAP
BPE4—(C61)

Judge Sue O’Connell ARPS EFIAP/g DPAGB BPE4 award
Airbourne by Adrian Lines MPAGB FBPE ARPS (C63)

Judge Nigel Forster award
Cheetah and Six Cubs by Ralph Snook ARPS
DPAGB EFIAP(C45)
PEOPLES CHOICE AWARDS

A Child’s Prayer by Ray Grace. ARPS DPAGB (C29)

22

United Photographic Postfolios of Great Britain
2018 Annual Competition
JUDGES
AV Judge – KEITH LEEDHAM FRPS EFIAP FIPF,
NH Judge - BARRY MEAD FRPS EFIAP/d2 MPAGB APAGB
SUE O’CONNELL ARPS EFIAP/g DPAGB BPE4*
NIGEL FORSTER
LEIGHTON HERDSON PRINT TROPHY & PLAQUE
C29 RAY GRACE ARPS DPAGB - A Child’s Prayer
LEIGHTON HERDSON PROJECTED IMAGE TROPHY & PLAQUE
C45 RALPH SNOOK ARPS DPAGB EFIAP - Cheetah and Six Cubs
ROLAND JONAS LANDSCAPE TROPHY & PLAQUE
C71 ANDREW NICOLL - Dawn Over Salina
AQS NATURAL HISTORY PRINT TROPHY & PLAQUE
C30 GEOFF JACKSON CPAGB - Tufted Grey Langur Monkeys
GLENN VASE NATURAL HISTORY TROPHY & PLAQUE
C45 RALPH SNOOK ARPS DPAGB EFIAP - Cheetah and Six Cubs
RALPH COUCHMAN CREATIVE TROPHY & PLAQUE
C36 SUE SIBLEY ARPS EFIAP APAGB - Child Snatchers
LIZ BOUD AUDIO VISUAL ROSE BOWL & PLAQUE
VAL JOHNSTON DPAGB – Cold, Cold Fields of Home
BRIAN DAVIS PORTRAIT TROPHY
C29 RAY GRACE ARPS DPAGB - A Child’s Prayer

BEST LARGE PRINT - PLAQUE
C71 ANDREW NICOLL - Dawn Over Salina
GOLD STAR CIRCLE - PRINTS
C29 SECRETARY - COLIN WESTGATE FRPS MFIAP MPAGB APAGB
GOLD STAR CIRCLE - PROJECTED IMAGE
C45 - SECRETARY BOB CRICK

23

United Photographic Postfolios of Great Britain
2018 Annual Competition
AWARDS, CERTIFICATES AND HIGHLY COMMENDED
C2/25 LARGE PRINT
KEN DICKENSON DPAGB
PETER MUDD ARPS CPAGB

Goldfinches Feeding
Brian

C3/14 LARGE PRINT
DENNIS DURACK LRPS

Jump for Joy

C4/26 LARGE PRINT
JOHN HACKETT
MILES LANGTHORNE DPAGB
PHILIP ANTROBUS FRPS

The Odd One
Early Dawn, Ambleside
Skipping

Certificate
Highly Commended
Highly Commended

C5 LARGE PRINT
NICK BODLE
NICK BODLE
BARON WOODS FRPS
DAVID JONES

Twisted Tree
Clints Grikes and Viaduct
Struggling For Life
Steam in the Snow

Certificate
Highly Commended
Highly Commended
Highly Commended

C7/17/21 SMALL PRINT
ADRIAN LINES MPAGB FBPE ARPS
ADRIAN LINES MPAGB FBPE ARPS
COLIN DOUGLAS ARPS DPAGB BPE4 AFIAP

Grief
Village Elders
The Assistant

Certificate
Highly Commended
Highly Commended

C9 SMALL PRINT
BARBARA BEAUCHAMP

Sandy Beach, Orkney

C10 LARGE PRINT
STEWART BAND LRPS
TONY BROOM CPAGB
TONY MARLOW LRPS

Late Arrival
The Warming Room
Charterhouse Ceiling

Certificate
Highly Commended
Highly Commended

C11 LARGE PRINT
LIZ SCOTT ARPS
COLIN SOUTHGATE FRPS DPAGB
MICK WILLIS

Autumn Mist, Wensleydale
Crushed Petals
The Quarry Man’s Hut

Certificate
Highly Commended
Highly Commended

C12 LARGE PRINT
JIM JENKINS LRPS
JIM JENKINS LRPS
IAN SQUIRE
JIM JENKINS LRPS

In Bruges
I Quite Like This One
Finding His Feet
A Craftsman at Work

Certificate
Highly Commended
Highly Commended
Highly Commended

C29 SMALL PRINT GOLD STAR CIRCLE
RAY GRACE ARPS DPAGB
RAY GRACE ARPS DPAGB
ANN MCDONALD ARPS DPAGB
HUGH MILSON MFIAP EFIAP/d
ROY ESSERY MPAGB
ISABELLA KNIGHT ARPS CPAGB
RICHARD CHERRY ARPS DPAGB EFIAP BPE5*
MONTY TRENT LRPS

A Child’s Prayer
A Child’s Prayer
Three Fishermen at Dusk
Colours of Seilebost
Morning Glory
Curves and Colours
Modern Art Gallery
Stairs in the Wood
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Certificate
Highly Commended

Certificate

Certificate

LEIGHTON HERDSON
BRIAN DAVIS TROPHY
Highly Commended
Highly Commended
Highly Commended
Highly Commended
Highly Commended
Highly Commended

United Photographic Postfolios of Great Britain
2018 Annual Competition
C30 SMALL PRINT
GEOFF JACKSON CPAGB
PAT BROAD ARPS EFIAP/b
TOM PECK
LIZ SCOTT ARPS
TED STURGEON LRPS

Tufted Grey Langur Monkeys
Evening Light, Aibufeira
Wake Valley Pond in the Mist
Autumn, Powdermill Woods
Sea Fret, Lindisfarne

AQS NH TROPHY
Highly Commended
Highly Commended
Highly Commended
Highly Commended

C31/32 PDI
IAN WHISTON DPAGB EFIAP.b ABPE
KEN DICKENSON DPAGB BPE3
BRIAN HALL
PAMELA JACKSON
PETER TULLOCH ARPS DPAGB EFIAP

Lion Cubs Sparring at Dawn
Should I
Sunset in the Masai Mara
Common Carder Approaching Meadowsweet
Drifting Past

Certificate
Highly Commended
Highly Commended
Highly Commended
Highly Commended

C36 LARGE PRINT
SUE SIBLEY ARPS EFIAP APAGB
JEFF FIELD CPAGB
LEO RICH ARPS EFIAP/g DPAGB

Child Snatchers
Poppies in the Mist
Cetti's Warbler on Reed

C45 (NH) PDI GOLD STAR CIRCLE
RALPH SNOOK ARPS DPAGB EFIAP
RALPH SNOOK ARPS DPAGB EFIAP
RALPH SNOOK ARPS DPAGB EFIAP
RALPH SNOOK ARPS DPAGB EFIAP
STEVE CHADD
BOB CRICK

Cheetah and Six Cubs
Cheetah and Six Cubs
Collared Aracari
Corn Bunting Dispute
Heron
Common Guillemot in Flight

C46 (NH) PDI
DOUGLAS HANDS ARPS
CZECH CONROY CPAGB
ALAN CORK

Newly Emerged Large Red Damsel
Crested Lark with Food
Flesh Fly Sacrophaga carnaria

C52 AUDIO VISUAL
VAL JOHNSTON DPAGB
VAL JOHNSTON DPAGB
JOHN LONG DPAGB ARPS Hon.PAGB

Cold, Cold Fields of Home
The Heart of Europe
Constable Story

RALPH COUCHMAN
Highly Commended
Highly Commended
LEIGHTON HERDSON
GLENN VASE
Highly Commended
Highly Commended
Highly Commended
Highly Commended
Certificate
Highly Commended
Highly Commended
Liz Boud Rose Bowl
Highly Commended
Highly Commended

C60 PROJECTED IMAGE (ON LINE CIRCLE)
ANN MCDONALD ARPS DPAGB
Gannets Sky Pointing
JAMES FINNIGAN
Kinetic Energy
MICHAEL TROTH
The Girl from Number 2
IAN WHISTON ABPE DPAGB AFIAP
Buffalo and Oxpecker
PAUL BURGESS
Don’t Leave Me
DENNIS DURACK
Oh! I Give Up

Certificate
Highly Commended
Highly Commended
Highly Commended
Highly Commended
Highly Commended

C61 PROJECTED IMAGE (ON LINE CIRCLE)
COLIN DOUGLAS ARPS DPAGB AFIAP BPE4* On the Edge
DEREK DOAR DPAGB
Bringing Home the Catch
PETER KARRY
Kolkata Street

Certificate
Highly Commended
Highly Commended

C62 PROJECTED IMAGE (ON LINE CIRCLE)
MIKE BENNETT LRPS CPAGB EFIAP BPE3*
Storm Trawler
LES HARRIS
Max

Certificate
Highly Commended

C63 PROJECTED IMAGE (ON LINE CIRCLE)
ADRIAN LINES MPAGB FBPE ARPS
Airborne
AYSU BILGIC LRPS EFIAP DPAGB AAPS
Communicating on Dusty Route
MARTIN HORTON
Down and Out In Srinagar

Certificate
Highly Commended
Highly Commended

25

United Photographic Postfolios of Great Britain
2018 Annual Competition
C64 PROJECTED IMAGE (ON LINE CIRCLE)
PHILIP WATSON
Goldfinch
PHILIP WATSON
Arctic Tern Returning with Food
MARTYN ADDISON-SMITH
New Forest Sun Rise

Certificate
Highly Commended
Highly Commended

C71 LARGE PRINT
ANDREW NICOLL
ANDREW NICOLL
JOHN BUTLER DPAGB APAGB

Dawn Over Salina
Dawn Over Salina
Aerial Confrontation

C72 LARGE PRINT
JOHN WIGLEY LRPS
JEAN ASHTON ARPS
JANE LINES MPAGB LRPS

South Downs
The Chair
King of Blackpool

Certificate
Highly Commended
Highly Commended

C73 LARGE PRINT
PAUL MEASOR
GRAHAM COLDRICK ARPS DPAGB APAGB
PAULA DAVIES FRPS EFIAP.s EPSA CPAGB
GRAHAM COLDRICK ARPS DPAGB APAGB

Dawn Abstract
Dodging the Ice Floes
Jack Frost
Sea Stack

Certificate
Highly Commended
Highly Commended
Highly Commended

C74 LARGE PRINT
GORDON SCOTT CPAGB
RALPH BENNETT ARPS CPAGB
SHIRLEY DAVIS CPAGB

Fun in the Snow
Onwards
Derbyshire Mist

Certificate
Highly Commended
Highly Commended

ROLAND JONAS
BEST LARGE PRINT
Highly Commended

CIRCLES
2015 - 25 Circles Submitted Gold Entries, 2016 - 25 Circles Submitted Gold Entries,
2017 - 25 Circles Submitted Gold Entries, 2018 - 25 Circles Submitted Gold Entries

GOLD PRINTS
2015 - 193 Gold Print Entries 2016 - 184 Gold Print Entries 2017 - 179 Gold Print Entries 2018 - 192 Gold Print Entries

PEOPLES CHOICE AWARD
2017 C73 SUE REVILL ARPS - Lone Runner 2018 A Child’s Prayer by Ray Grace. ARPS DPAGB (C29)

SELECTOR’S PERSONAL CHOICE
NH JUDGE BARRY MEAD FRPS EFIAP/d1 C61 COLIN DOUGLAS ARPS DPAGB AFIAP BPE4 - On the Edge
JUDGE SUE O’CONNELL ARPS EFIAP/g DPAGB BPE4* C63 ADRIAN LINES MPAGB FBPE ARPS – Airbourne
JUDGE NIGEL FORSTER C45 09 RALPH SNOOK ARPS DPAGB EFIAP - Cheetah and Six Cubs

My Thanks go to Ray Grace, Helen, Adrian and Lyne for helping and organizing the
Event.
Ken Payne – Exhibition Secretary
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The Conference 2018
A small selection of non award winning entries in the 2018 Exhibition, for the full exhibition please buy
the DVD or Stick from Ken Payne. See back cover.

(1)

(5)

(9)

(2)

(3)

(6)

(4)

(7)

(10)

(11)

1. C72 JANE LINES MPAGB LRPS - Child Labour
2. C63 MARTIN HORTON - Wild Dance
3. C7.17.21 TERRICK MEAKIN ARPS APAGB - Soldier Girl
4. C64 12 PATRICK JOHNSON -Allium Head
5. C61 12 TONY LOCKWOOD - Hoverfly
6. C62 04 JONATHAN RATNAGE - Hare Drying
7. C31.32 IAN WHISTON DPAGB EFIAP.b ABPE - Lion Cub on Mound
8. C46 MARY JENNINGS LRPS CPAGB - Common Blue Polyommatus on Agrimony
9. C5 DAVID JONES - Grey Wolf Affection
10. C10 ANDREW ROTHERY - Singing Ringing Tree
11. C12 IAN SQUIRE - In Full Flight
12. C60 JOHN WHEELEY - Lift Off
13. C73 HOWARD FISHER LRPS CPAGB - Rooster
14. C7.17.21 JIM HAYDOCK - Orange Sunrise (osteospermum)
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(8)

(12)

(13)

(14)

Dpi, ppi and Print Size
By
Mervyn Edwards LRPS, CPAGB (C7/17/21 & C64)

So often I see the terms dpi and ppi used indiscriminately and interchanged. They refer two
completely different parameters and should not be confused.

DPI
This term refers to ‘dots per inch’, and is a physical parameter determined by the printer.
When digital printers first became available, they were dot matrix printers using pins to
strike an inked ribbon on to the paper. A typical printer might have a print head consisting of
9 vertical pins which are actuated as the head passes over the paper to construct a
character. Clearly this type of print head has a limited resolution. Modern ink jet printers
are a sophisticated upgrade to this principle where dots of ink are projected on to the
paper. Laser printers operate on much the same principle, except that the print pattern on
the paper is made electrostaticly by means of a laser, and the toner is attracted to the
electrostatic ‘dots. Clearly there is a limit to the number of dots that can be generated by
any of the above methods. The number of dots that any of these printers can lay down on
the paper is the parameter ‘dpi’. Modern printers may have a dpi of 7200. Curiously, some
printers still stick to the resolution which can be traced back in history to Caxton, where the
number 72 is significant. Hence we have 72 points to an inch. For example, the resolution of
Epson printers are generally multiples of 72 and hence 288, whereas Canon, laser and
commercial printers work on multiples of 300. The high resolution of modern printers
reduces the limitations we used to experience when the printer could only lay down say 300
dots per inch.
You cannot therefore specify the dpi in a photograph as it is a physical parameter only of the
printer.

PPI
This term is short for ‘pixels per inch’.
When we record a digital image in a computer file, each byte of information in the file
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corresponds to a pixel. (for the moment I am ignoring compressed data contained in jpg
files.) The data has no relationship to the size of the print. In order to print the data
contained in a file to a specific print size, we need to specify to the printer how many pixels
of the data should be printed per inch of the paper. Thus if we have an image which is 3000
pixels by 2000 pixels and we want a final print which is 10 inches wide, we would tell the
printer to print 300 ppi. This print density is such that the human eye will not tell that each
inch of the print consists of 300 dots. If the printer has a higher resolution of say 3000 dpi, it
would print 10 ink dots per pixel. The information telling the printer what ppi to use is only
one byte of the digital data file. Thus, changing the ppi of an image file will not affect the
size of the data file. If you are printing to an Epson printer with a horizontal resolution being
an increment of 72, a ppi of 288 is usual. Similarly, if printing to a Canon, laser printer to
producing an output for a commercial printer, a ppi of 300 should be used. This is to prevent
the printer having to extrapolate between dots and causing a reduction in the printed
quality.
Images prepared for digital projection are a special case. In this case it is usual to prepare
the image so that the pixel count is the same as the projector. Hence if you are sending to a
projector with a resolution of 1024 x 768 pixels, the image should be resized to an image
1024 pixels x 768 pixels. In this case the ppi is irrelevant and will have no effect on the file
size or the image quality. As we normally use compressed jpg files to send to a projector,
image quality may be affected when we choose a lower ‘quality’ setting when generating the
jpg file. This will affect the file size.
If the projector aspect ratio is different to that of the image you wish to project, I use a
different technique. If the pixel count of the file is different to that of the projector, there is
a problem. The projector may handle the file in a variety of ways. It could stretch the image
to fit, which is not what you want, or it may attach a background colour to your image to fill
the space, which may or may not be what you want. It is better to determine the extra
space to your liking. For example, if I am to use a projector having a pixel count of 1920 x
1080, this is a 16:9 aspect ratio. This may not be the same as my image, which is probably
4:3 or 3:2 aspect ratio. My approach here is to make a blank image 1920 x 1080 pixels, with
a black background. Make sure you set the colour space and either a 16 bit or 8 bits blank.
This should match the bit depth of the image you are going to paste. Then I open the
required image and copy and paste it as a new layer into the blank image. Using photoshop
Edit>Transform>Scale I adjust the pasted image to fit inside the blank background. It is
always worth making the scaled image slightly smaller than the background, as I have found
some projectors do not project to the very edge of the image. When you are happy with the
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result, flatten the image, and save as an 8-bit jpg file. Obviously, if you prefer a white or
coloured background for the slide, then determine the colour when you make the blank
background.

Image resizing
I remember the first time I printed an image on my colour printer. I ended up with a whole
A4 sheet coloured blue! Why? Well it was the top left-hand corner of my image which
happened to be sky. I was attempting to make an enormous print as I had all the factors
wrong. When we had low resolution cameras and low-resolution printers, printing to a
specific size could be daunting to get a good result. These days it is so much easier.
I find the easiest way to make a print to the dimension required is to use the
much-underutilised Photoshop Crop Tool. I always retain as many pixels in my saved file as
possible. When I come to print, then is the time I would resize it. Generally, I suspect most
photographers want to make a print a specific size, let’s say 10 inches by 8 inches. The
process is to select the crop tool and in the boxes at the top of the screen enter the
horizontal and vertical dimensions, 10 ins x 8 ins. At this stage also set the ppi, I suggest
either 300 or 288 ppi. Crop the image to your liking, and even if you select a small area in
the centre of the image, the resulting crop will be 10 ins x 8 ins. Photoshop will have done
all the calculations for you. You can check this in the rulers at the top and side of the image.
Now when you come to print the image, so long as the paper size is larger than the image
size, the resulting print will be exactly 10 ins x 8 ins. The printer will do all the calculations
for you to set up how it deals with the data. When you are asked to save the file, do not
overwrite your high-resolution file!
If you have Photoshop CC, It is possible to save a number of crop settings which can be
recalled later.
In order to make these instructions as simple as possible, I may have cut some corners, or
not gone into the most intimate detail.

Mervyn.
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Circle Types & Secretaries
LARGE PRINT CIRCLES
2/25

Tony Elliott APAGB

circle2-25@uppofgb.com

3/14

Ralph Bennett ARPS CPAGB

circle3-14@uppofgb.com

4/26

Philip Antrobus FRPS

philip.antrobus@virgin.net

5

Nick Bodle

circle5@uppofgb.comm

10

Peter Young CPAGB AFIAP APAGB

circle10@uppofgb.com

11

Paul Damen

circle11@uppofgb.com

12

Jim Jenkins

circle12@uppofgb.com

36

Ian Platt MFIAP FRPS EFIAP/g Hon.PAGB

circle36@uppofgb.com

71

Liz Boud

circle71@uppofgb.com

72

Brian Davis APAGB

circle72@uppofgb.com

73

Paula Davies FRPS EFIAP/s EPSA

circle73@uppofgb.com

74

Ralph Bennett ARPS CPAGB

circle74@uppofgb.com

SMALL PRINT CIRLES
7/17/21

Colin Douglas ARPS AFIAP DPAGB BPE4

circle7-17-21@uppofgb.com

9

Dennis Apple

circle9@uppofgb.com
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Colin Westgate FRPS MFIAP DPAGB APAGB

circle29@uppofgb.com

30

Janice Payne ARPS

circle30@uppofgb.com

PROJECTED IMAGE CIRCLES
31/32

Ian Whiston EFIAP/b DPAGB ABPE

circle31-32@uppofgb.com

45

Bob Crick, Natural History

circle45@uppofgb.com

46

Douglas Hands ARPS, Natural History

circle46@uppofgb.com

ONLINE CIRCLES
60

Paul Hoffman CPAGB, BPE3* EFIAP

circle60@uppofgb.com

61

Ken Payne

circle61@uppofgb.com

62

Ken Payne

circle62@uppofgb.com

63

Ken Payne

circle63@uppofgb.com

64

Paul Hoffman CPAGB, BPE3* EFIAP

circle64@uppofgb.com

AUDIO VISUAL CIRCLE
52

Val Johnston DPAGB

circle52@uppofgb.com
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